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This chapter describes the tools for drawing and editing objects. You
can draw objects anywhere on the page, even overlapping other
objects, but not across page boundaries. There are three types of
objects: frames, lines and ruler guidelines.

Frames are the basic building blocks in Ovation Pro. They are used to
hold the text and pictures that appear on the page and are normally
rectangular (but may be any closed shape). 

Lines are normally straight or curved open paths, but may be any shape
(open or closed). Even if line paths are closed, they cannot contain text
or graphics. Typically, Lines are used to add additional graphics to the
page and for this purpose are better than frames because they use less
memory.

Ruler guidelines are used to help align objects on the page.
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8.1 Drawing frames
Frames in Ovation Pro may be rectangular,

elliptical or irregular. In the latter case they may

be constructed from straight and curved line

segments. To draw a frame, left click on the

Frame tool and on the required shape from the

toolbox (fig 8.1).

Normally after drawing a frame or line, the Select

tool is automatically re-selected ready for text

entry. If you wish to draw a number of frames in

succession, choose the Frame tool by right

clicking, whereupon it will remain selected until

another tool is chosen.

An empty frame can contain either text or a

picture. If you wish to put a picture in a text

frame, you must delete all the text first. Similarly,

if you want to put text in picture frame, you must

delete the picture first. To delete a picture select it

first by double clicking on it and then delete it

using the menu

MenuêEditêDelete picture Ctrl+K

Rectangular Frames
Move the crosshair to where you want one corner

of the rectangle to be, then left click and drag to

the opposite corner. Finally release the button

complete the operation (fig. 8.2).

To draw a perfect square, hold down Shift while

drawing the rectangle (or use grid lock):

MenuêViewêGrid Ctrl+Shift+G

Elliptical or Circular Frames
Ellipses are arranged to fit within a rectangular

area. Move the crosshair pointer to the centre of

the area then left click and drag to the required

size. Finally release the button to complete the

operation (fig. 8.3).

To draw a perfect circle, hold down Shift while

drawing the ellipse (or use grid lock).
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Fig. 8.1 - The toolbox.

Frame tool

Rectangle

Ellipse

Straight Line Segment

Curved Line Segment
Fig. 8.5 - A curved-sided
irregular frame.

Fig. 8.2 - A rectangular
frame.

Fig. 8.4 - A straight- sided
irregular frame.

Fig. 8.3 - An elliptical
frame.



Irregular Frames
Choose Straight Line Segment or Curved Line

Segment from the toolbox. Left click where you

want the line to start, then move to the endpoint

and left click again. You can keep adding line

segments to the path by moving to the endpoint of

each new line and left clicking. Alternatively click

and drag to each new endpoint, to allow auto-

scrolling at the edge of the window. You cannot

go beyond the page boundaries.

At any time you can change between straight and

curved lines by choosing the required type from

the toolbox. To draw perfectly horizontal or

vertical lines, hold down Shift to constrain pointer

movement to the horizontal or vertical.

Left double-click or right click to finish the path.

When drawing frames, the path is closed

automatically (figs. 8.4 & 8.5).

The shape of irregular frames can be edited in

Path Edit Mode (see 8.11).

8.2 Drawing lines
The Line tool in allows you to draw rectangles,

ellipses, straight lines (fig. 8.7) and curved lines

(fig. 8.8). You can draw single lines or sequences

of connected lines. By default lines sequences are

open path, but can be closed (fig. 8.9 & 8.10)
using an option in Path Edit Mode (see 8.11).

To draw a line, choose both the Line tool and the

required shape from the toolbox (fig. 8.6). The

method of drawing lines is identical to that

described on the previous page for frames.

Remember that objects drawn with the line

tool cannot contain text or pictures.
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Curved Line Segment

Line tool

Fig. 8.6 - The toolbox.

Fig. 8.7 - A straight line.

Fig. 8.10 - A closed path
line.

Fig. 8.9 - An open path
line.

Fig. 8.8 - A curved line.



8.3 Text Overflow and Linking Frames
Once you have drawn a frame, you may type or

import text into it (see 3.1 & 3.3). If you type past

the bottom of the frame or import a story that is

too big, the overflow flag will be displayed in the

bottom right corner of the frame (fig. 8.12). In this

situation, the overflowed text will not be visible

and cannot be edited.

There are a number of things you can do to

remove the overflow flag:

1. Delete some of the text to make space for the

overflowed text.

2. Make the frame big enough to display all of

the text.

3. Link the overflowed frame to another empty

frame, so that the text will automatically flow

into the second frame.

Linking Frames
To link two frames, select the Link tool from the

toolbox (fig. 8.11a). Now click in the first frame

and drag the pointer to the second frame. During

this operation, the pointer will change to a link

symbol. After linking, the overflow flag will

disappear from the first frame, but may be

displayed in the second frame if there is still not

enough space for the entire text story (fig. 8.13). If
you wish you can then link the second frame to a

third frame. You can link any number of frames

together in this way, even if they are on different

pages.

Editing Text in Linked Frames
Once frames are linked, text will flow automa-

tically between them, and may be edited as

normal. Caret movement will work correctly

between the frames, and you may select text

across them by clicking or dragging in the usual

way.
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Fig. 8.11a - The toolbox.

Link tool

Fig. 8.13 - Two linked frames with link shown.

Fig. 8.12 - Frame with overflow flag.

Fig. 8.11b - The info palette having selected
the Link Tool



Linking Frames on Master pages.
Frames on the Master pages can be linked. As

well as the usual type of linking there is another

kind called ‘auto-linking’. This means that when

the text in a master frame overflows in the

document, it will flow into the same frame on the

next page i.e. a page will be automatically created

with new frames linked to those on the preceding

page.

Often this feature is used with a chain of linked

frames, where the last frame in the chain is auto-

linked to the first frame in the chain. When the

last frame overflows, a new page is inserted and

the text flows into the first frame on the new page.

To create an auto-link, use the Link tool in the

usual way, but drag back onto the first frame in

the linked chain (fig. 8.14). In the case of a single

frame, drag back onto that frame (fig. 8.15).

An 'auto-link' is shown in green when the Link

tool is selected. 

It is possible to have more than one auto-link

chain in a chapter.

To delete an auto-link, choose the Link tool, click

over the link so that it is selected i.e. shown in red.

Now press Delete or click the 'Delete link' button

on the info palette.

A typical use of auto-linking is a template

document for labels. The idea is to draw the labels

on the master pages so that as each page is filled,

a new page of labels is inserted. Each label on the

master page is linked to the next label, and the last

label on the master page is linked to the first.

To create this type of document, open the master

pages and draw the labels as required. Now use

the Link tool to link all of the labels in the order

that you wish text to flow through them. Link the

last label back to the first label. This link will be

shown in green, indicating that it is an auto-link

and will generate a new page when it overflows.

Close the master pages, and save the document as

a template.

You can now type in the labels. Note that since we

are using linked frames, you can use Ctrl Return

to start a new label.

If you wish to import data e.g. names and address

from a file, the data needs to be formatted

correctly first. Each field should be separated by a

Line Feed (0x0A) or Carriage Return (0x0D) or

both and each record by a Form Feed (0x0C). If

your data is in CSV format, then you will need to

convert your file before it is imported.

 Name<0A>
 Address 1<0A>
 Address 2<0A>
 Postcode<0C>
 Name<0A>
 Address 1<0A>
It is also possible to use mail merge to solve this

problem (see 12.5).
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Fig.8.15 - Auto-linking column 1 results in overflowing
text appearing on next page in column 1.  Frame 1
overflows to frame 2, then to frame 1 on following page.
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Fig.8.14 - Autolink: text flows from frame 1 to 2, then to 3
and to 4 and finally to frame 1 on following page. 

The auto-link of the
Main Master frame
is also shown



Show Flow
When you choose the Link tool, arrows are drawn

in the document indicating where text flows

(fig. 8.13).

Changing a Link
If you link from a frame that already has an

outward link, the original link is removed and text

flows according to the new link.

Unlinking Frames
To unlink frames, choose the Link tool so that you

can see the arrows that show text flow. To remove

a link, left click on the appropriate arrow, so that

it is highlighted i.e. shown in black (fig. 8.16).
Now press Delete to remove the link. Or click on

the Delete box on the info palette (fig. 8.11b).

An auto-link will be shown in red when selected.

In the case of a chain of linked frames with an

auto-link the auto-link must be removed before

you can remove or change the other links.

Removing a link has the effect of removing the

text from the linked frame (and any subsequently

linked frames) and joining it back to the end of the

previous frame. This will cause the previous

frame to overflow, but no text will be lost.

Frame Break
You can force the caret to the start of the next

linked frame by pressing Ctrl Return, or by

choosing

MenuêMiscêInsertêNew page.

The break character may also be deleted, causing

text that follows to flow back into the previous

frame.

Special Notes
The following points should be considered when

linking frames:

1. You cannot link to or from the Main frame,

since this is already linked.

2. You cannot link picture frames.

3. If a frame contains text, it can only be linked

to an empty frame that doesn’t already have an

inward link or to the first frame of a chain of

linked frames as long as these linked frames

are empty.

4. If a frame is empty, it can be linked to any text

frame that doesn’t already have an outward

link or to the first frame of the chain of linked

frames.

5. You cannot delete linked frames. But a page

with linked frames can be deleted if all linked

frames are within that page only.

6. You cannot cut or copy linked frames to the

clipboard, or copy linked frames using drag

and drop. 
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Fig. 8.16 - Two linked frames with highlighted arrow.



8.4 Drawing Aids
There are a number of facilities available to help

you draw and manipulate objects.

Cancelling an Operation
Most operations concerned with manipulating

objects can be cancelled by pressing Esc at any

time. So if you are in the middle of drawing a

frame, pressing Esc will cancel the operation.

Auto Scrolling
The document window will automatically scroll if

you drag close to its edges. The speed of scrolling

is determined by how close the pointer is to the

window edge; the closer it is, the faster it scrolls.

Nudging the Pointer
When drawing, moving and resizing objects you

may position the pointer more accurately by

pressing the cursor keys to ‘nudge’ it one pixel in

the required direction. In this case Object snap

(see next paragraph) is overruled.

Object Snap
When drawing, moving or resizing objects, the

edges of the objects snap into alignment with the

edges of other objects on the same page. Top

edges snap to top edges, bottom edges to bottom

edges etc (fig. 8.19).

Object snap may be disabled on Preferences

(see 15.13), and is automatically disabled if grid

lock is enabled.

Grid
If object grid lock is enabled (see 7.4), and an

object is drawn or resized, its edges will snap to

the grid. If an object is moved, it will jump in

steps of the grid spacing.

If grid lock is enabled, the MenuêObjectêSnap

to grid option will snap the top left corner of the

selected object to the nearest grid point. The size

of the object is not altered.
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Fig. 8.17 - The selected frame is dragged in the direction of the arrow so that the left and
bottom edges snap to the larger frame. The right edge of the selected frame is then
dragged to the right until it snaps to the right edge of the larger frame.



Ruler Guidelines
MenuêViewêOptionsêRulers Ctrl+R

When rulers are enabled (see 7.3), you can draw

your own vertical or horizontal guidelines across

the page. Edges of object will snap to these

guidelines when dragged close to them.

To draw a vertical guideline, left click on the

horizontal ruler at the required position.

Alternatively, left click then drag the guideline to

the required position. To draw a horizontal

guideline, do the same, but on the vertical ruler.

To move a guideline, move the pointer over the

guideline, so that the pointer changes to the

guideline tool (fig. 8.18). Now drag the guideline

to the required position. You can also drag a

number of selected guidelines in a single

operation.

To select guidelines, left click over the first one,

then Ctrl left click over other guidelines to add

them to the selection. Selected guidelines are

shown in red.

To move a selected guideline to an exact position,

choose MenuêObjectêModify and enter a value

in the dialogue box displayed (fig. 8.19).

To delete a guideline drag it to the extreme edge

of the page. Alternatively, to delete selected

guidelines choose EditêDelete. 

To delete all vertical guidelines, Ctrl left click on

the horizontal ruler. To delete all horizontal

guidelines Ctrl left click on the vertical ruler.

Guidelines are normally drawn over the top of all

frames, but an option on 

MenuêMiscêPreferences Ctrl+Shift+P

 allows them to be drawn behind instead

(see 15.13). Snap to ruler guidelines may be

disabled on MiscêPreferences (see 15.13), and is

automatically disabled if grid lock is enabled. 

98 DRAWING & EDITING OBJECTS CHAPTER 8

Fig. 8.18 - Document with vertical and horizontal ruler guidelines. Fig. 8.19 - Modify guideline.



8.5 Selecting objects
Before you can make changes to an object you

must select it. Ensure that the Select tool is active

(fig. 8.20) then left click over the object. This

selects the object and deselects any other objects.

When an object is selected, it is enclosed in a red

‘bounding box’ with 8 blue ‘handles’ located

around its edges. The bounding box is a

rectangular guideline that completely encloses the

object (fig. 8.21 & 8.22). A handle is a small

square which can be dragged to resize the object.

In addition to frames and lines, you may also

select ruler guidelines. When selected they are

shown in red, but do not have handles.

You can select more than one object by holding

down Control and left clicking each additional

object. Control left clicking on an object that is

already selected causes it to be deselected. 

Another way of selecting all the objects in an area

is to construct a select box around the area by

holding down Ctrl Shift and pressing the left

mouse button at one corner of the area to be

selected and dragging the box to the opposite

corner. Release the button when all the objects to

be selected are wholly within the select box; the

objects will then be selected.

If the object you want to select is obscured by

another object, hold down Ctrl Shift and double-

click over the top object to select the object

beneath. You may keep doing this to select

progressively deeper objects until you eventually

return to the top object.

If you want to permanently group a number of

objects, use ObjectêGroup or Ctrl+Shift+K

(see 9.11).
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Fig. 8.20 - The Select tool.

Select tool

Fig. 8.21 - An active
rectangular frame with eight
handles for resizing.

Fig. 8.22 - An active elliptical
frame with eight handles for
resizing.



8.6 Moving Objects
To move an object, first ensure the Select tool is

selected. Then left click over the object and keep

it pressed and completely still until the Move

pointer appears (fig. 8.23). Now drag the object to

its destination (which may be anywhere on the

same page) and release the button. If you hold

down Ctrl, you may drag the object immediately

with the right button, without holding the button

down until the Move pointer appears.

If you have a number of objects selected, moving

one of them will move the entire selection. You

can move a mixed selection of frames, lines and

ruler guidelines if you wish.

To constrain movement to the vertical or

horizontal, hold down Shift while dragging.

You can position objects precisely using the info

palette or the Modify dialogue box (see 9.1).

Using the Info Palette
X and Y on the info palette (fig 8.24) are the

coordinates of the top left corner of the selected

object or group. Coordinates are measured from

the top left corner of the page. X and Y may be

modified to change the position of the object.

Press Return after modifying the values to update

the document.

If there is a selection of objects, X and Y refer to

the first object selected. In this case if X and Y are

modified, the first object is moved to the position

specified and the rest are moved proportionally.

Drag and Drop
You can move or copy objects using the drag and

drop facility. Unlike the normal move operation

described above, you can drag and drop objects to

any page in the same document or in a different

document.

To drag and drop selected objects, hold down Alt

then drag them to the required position.

If you drag and drop within the same document,

objects are moved; if you drag and drop to another

document, objects are copied.

If you hold down Shift Alt while dragging, the

above operations are transposed. So, if you drag

and drop within the same document, objects are

copied; if you drag and drop to another document,

objects are moved.

If you start a drag operation and wish to cancel it,

press Esc.

Please note that you cannot drag and drop master

objects or linked frames. But you can move linked

frames within a chapter.

For drag and drop of selected text see 3.8.
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Fig. 8.23 - The
Move tool moves

Fig. 8.24 - The info palette gives the position of the selected object. You can reposition it
by changing the X and Y values.



8.7 Resizing Objects
To change the shape or size of an object move the

pointer over one of the 8 handles so that the

Resize pointer appears (fig. 8.25). Now press the

left mouse button and drag the mouse until the

object is the size and shape that you want. There

are two types of handles:

• Corner handles will resize the object both

horizontally and vertically.

• Centre handles will make the object either

wider or longer.

If you hold down Ctrl while dragging, the original

shape (aspect ratio) of the object will be

maintained. If you hold down Shift, the object

bounding box shape will be constrained to a

square.

If you have a number of objects selected, resizing

one of them will resize the rest proportionally.

You can resize objects precisely using the info

palette or the ObjectêModify dialogue box or F7

(see 9.2). The sizes W and H mentioned on the

info palette refer to the first object selected.

Using the Info Palette
W and H on the info palette (fig. 8.26) are the

width and height of the selected object or group.

W and H can be modified to change the size of the

object. Press Return after modifying the values to

update the document.

If there is a selection of objects, W and H refer to

the first object selected. In this case if W and H

are modified, the first object is resized as specified

and the rest are resized proportionally.

X and Y on the info palette refer to the distance

from the top left corner of the page to the top left

corner of the object frame. By changing these

values you can reposition the object frame.

Resizing Picture Frames
If you resize a picture frame using the right mouse

button, the picture is resized too. This only

functions in both X and Y directions if Aspect

lock has not been selected. This can be set in 

MenuêPictureêModify picture F6

If aspect lock has been set the picture will be

resized according to the vertical size of the frame.
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Fig. 8.26 - The info palette gives the size of the selected object. You can resize it by
changing the W and H values and move it by changing the X and Y values.

Fig. 8.25 - Move the pointer over a handle
and drag the resize tool to resize the object.



8.8 Rotating Objects
You can rotate text frames, picture frames and

lines. To rotate an object choose the Rotate tool

on the toolbox (fig. 8.27) then left click and drag

on any part of the object until it is at the desired

angle (fig. 8.24). You may select a number of

objects either before or after choosing the Rotate

tool, and rotate them all by dragging on any object

in the selection. 

The centre of rotation for the object or selection is

indicated by a small crosshair which is initially at

the centre of the object or selection, but may be

dragged to another position. Please note that if

you choose the rotate tool when there is no

selected object, the crosshair will not appear until

you select one or more objects.

Note that the Picture frame info palette does not

show the angle of rotation of the frame but the

angle of rotation of the picture within the frame

(fig. 10.9).

Using the Info Palette
When the Rotate tool is chosen, the info palette

provides a number of options concerned with

rotating objects (fig. 8.28).

A is the angle of rotation of the selected object or

group. The angle of rotation is in degrees and is

applied anti-clockwise. You may type in a new

value followed by Return to rotate the object to

the desired angle. Alternatively click on the up

and down icons to increase or decrease the angle.

If there is a selection of objects A refers to the

first object selected. In this case, if A is changed,

the first object is rotated as specified and the rest

are rotated incrementally.

Clicking on the 3 x 3 grid will position the

crosshair at the same relative position on the

selected object or selection. The 9 points relate to

the centre, the fours corners and the centres of the

four sides.

If Crosshair is selected, objects are rotated about

the crosshair, otherwise they are rotated about

their centres.

102 DRAWING & EDITING OBJECTS CHAPTER 8

Fig. 8.28 - When the Rotate tool is chosen, the info palette provides options to set the
angle of rotation and alter the position of the centre of rotation.

Rotate tool

Fig. 8.27 - The toolbox.

Fig. 8.24 - Use the Rotate tool to rotate
the object around the crosshair.

      Crosshair



8.9 Editing Objects using the Edit Menu
MenuêEditê..........

This section describes the options on the Edit

menu (fig. 8.29) concerned with objects. Some of

these options use the clipboard (fig. 8.30) which

can be viewed using the Clipboard option on the

View menu (see 2.2).

The options Clear, Cut, Copy and Delete apply

to selected objects provided that no text or picture

is selected, otherwise they will apply to the text or

picture.

Clear
Clear deselects all selected objects.

Select All Ctrl+A

Select all selects all objects on the current page.

This is only possible if there is no active frame,

otherwise it selects all the text in the active frame.

Cut frame/line/selection Ctrl+X

Cut deletes selected objects, and places them on

the clipboard, overwriting the previous contents.

Copy frame/line/selection Ctrl+C

Copy copies the selected objects onto the

clipboard, overwriting the previous contents.

Paste frame/line/selection Ctrl+V

Paste inserts the object or objects that are on the

clipboard, into the document. After choosing

Paste, move the crosshair which then appears to

the top left corner of where the object is to be

pasted, and left click. 

An object can be pasted into any Ovation Pro
document, not just the one from which it was cut

or copied. After pasting, the clipboard contents

remain unchanged.

This option is only available if the clipboard

contains an object or selection of objects.

Delete frame/line/guideline/selection
This option deletes the selected object or objects. 

Undo / Redo Ctrl+Z  /  Ctrl+Y

Undo cancels the last operation performed,

restoring your work to its previous state. Redo

cancels the last undo operation performed.

The Undo and Redo options when applied to

objects are identical to those described previously

for text (see 3.4).
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Fig. 8.29 - The Edit menu. Fig. 8.30 - The clipboard containing a text frame.



8.10 Embedding Objects
MenuêEditêEmbed object

Normally in Ovation Pro objects are anchored to

the page, but EditêEmbed object allows you to

embed an object or group into a text story such

that the object moves with its associated text when

the text reflows.

How to Embed an Object
First draw the object anywhere on the page and

Cut or Copy the object so that it is placed on the

Clipboard. Now position the caret at the required

insertion point in the text (fig. 8.31), and choose

Embed object.

The embedded object is aligned with the text’s

baseline and behaves just like a large character

which moves with its surrounding text when

editing causes text reflow. The text after the caret

is shifted to the right to make space for the object,

and the line of text is shifted down to

accommodate its height (fig. 8.32). 

Important Points
• Embed object is only available if the

clipboard contains an object or group of

objects. If the clipboard contains a selection of

objects that are ungrouped, only the first object

in the selection will be embedded.

• You cannot ungroup an embedded group.

• You can resize an embedded object as you

would a normal object, but you cannot move it

except by moving the text in which it is

embedded. 

• A text overflow will occur if you try to embed

an object into a frame that is too small to

contain it.

• After embedding, the clipboard contents

remain unchanged.
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Fig. 8.31 - A text frame with the caret positioned
ready for embedding an object.

Fig. 8.32 - An embedded frame is aligned to the
text baseline. The text is shifted to the right and
the line moved down to make space for the object.



Modifying an Embedded Object

MenuêObjectê……

• If the embedded object is a frame, all the

normal operations can be applied to the text or

picture contents of the frame.

• From the ObjectêModify dialogue box or F7

(see 9.2) you can apply all options except for

X, Y and Lock.

• From the ObjectêText flow dialogue box you

can only apply Standoff.

• Border and Shape can be applied, but all

other options on the Object menu are not

applicable.

• You can select an embedded object just like

normal text and Cut, Copy, Paste and Delete

it using options on the Edit menu.

• An embedded object can be placed in a

paragraph on its own by ensuring there is a

Return character directly before and after it

(fig. 8.33).

• Options on the Format dialogue box such as

Indent, Alignment, Space before and

Space after can be applied to a paragraph that

contains an embedded object. Tabs can also be

applied.

• The bottom of an embedded object is aligned

with the text’s baseline, but you can shift it up

and down vertically using V.Shift on the

Modify text dialogue box. All other options on

this dialogue box are not applicable.

• Relative leading (i.e. that specified as a

percentage) is calculated from the size of the

text in the line and not from the size of the

embedded object.

Embedding Pictures Directly
You can drag a picture directly from disc into a

text story. A picture frame is then automatically

embedded at the pointer position, and the picture

placed in it. 
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Fig. 8.33 - Embedded frame in a separate
paragraph with Centre alignment.



8.11 Path Edit Mode
MenuêObjectêShape Ctrl+H

The shape of objects drawn using straight and

curved line segments, can be edited in Path Edit

Mode.

You cannot edit the shape of rectangles or

ellipses without changing them to polygons

first using ObjectêShape (see 9.9).

To edit a path, choose the Path Edit Mode tool on

the toolbox (fig. 8.34) and left click on the path to

be edited. This is not necessary if an object is

selected before entering this mode.

The end points of each segment are shown in blue

and may be dragged to reposition them (they will

snap to the grid if grid lock is enabled). You can

constrain movement to horizontal or vertical by

holding down Shift while dragging. When moving

a point you may use the cursor keys to nudge the

pointer in any direction.

Left click over an end point to select the line

segment. Left click whilst holding down Control

on a point to add or remove a line segment to or

from the selection. Selected end points and line

segments are displayed in red. If you have a

number of end points selected, moving one of

them will move the entire selection.

If you select the end point of a curved segment,

the control point for the Bezier curve is shown in

orange and may be dragged to reposition it

(fig. 8.35). If you hold down Shift while you drag

a control point, the corresponding control point in

the next curve is also moved to keep the angle of

join constant.

To edit another path, left click over it. If the object

you want to edit is obscured by another object,

holding down Alt and double-clicking over the top

object will select the one underneath. You can

keep doing this to select progressively deeper

objects.

If you find that editing paths is too slow because

surrounding text is continually being redrawn, you

can disable the redraws using an option on

MenuêMiscêChoicesêViewê....

Deselect 'Instant updates on path edit'  (see 15.6).

When you have finished editing your object, leave

Path edit mode by choosing the Select tool on the

toolbox.

Please note that in Path Edit Mode most of the

usual Ovation Pro operations are not available.
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Fig. 8.34 - The toolbox.

Path Edit Mode tool

Fig. 8.35 - An irregular object in path edit mode with
an endpoint selected. The two control points may be
dragged to change the angle of join.

Selected
end point

Control points



Path Edit Options
In Path Edit Mode, the info palette provides a

number of options concerned with editing the

selected path (fig. 8.36). All of the options may be

applied to a single selected segment or to a

selection of segments.

The writable icons X and Y are the coordinates of

the selected end point. Coordinates are measured

from the ruler origin (normally the top left corner

of the page). These values may be modified to

change the position of the point. If there is a

selection of points, X and Y refer to first end point

selected. In this case, if X and Y are modified, the

first end point is moved to the position specified

and the rest are moved incrementally.

Change to straight line changes the selected

curved line segment or move segment into a

straight line.

Change to curve changes the selected straight

line segment or move segment to a curved line.

Change to move changes the selected straight line

segment or curved line segment to a move

segment i.e. an invisible line.

Make horizontal moves the selected end point

either up or down to make the line segment

horizontal (relative to the object rotation).

Make vertical moves the selected end point either

left or right to make the line segment vertical

(relative to the object rotation).

Add point adds a new segment into the selected

segment, of the same type as the selected segment.

Delete segment deletes the selected segment.

Flatten path straightens the join between two

curved lines or a straight line and a curved line, so

that the tangent is continuous at that point.

Open/close path turns a closed path into an open

one, or an open path into a closed one.

Snap to grid aligns the selected end point to the

grid. The grid or grid lock must be enabled for this

option to work.
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Fig. 8.36 - The info palette in Path Edit Mode

Add point

Delete segment

Flatten path

Snap to grid

Open/close path

Change to curve

Change to move

Make vertical

Choose curveChange to straight line

Make horizontal



Editing the Inset and Standoff Curves
The description above explains how to edit the

shape of objects constructed using straight and

curved line segments. However, you may also edit

the ‘curves’ which repel text inside and outside a

frame. This facility only applies to frames, and not

lines which are always transparent and do not

repel text. You cannot edit the Inset or Standoff

curves for rectangles or ellipses without changing

them to polygons first using the ObjectêShape

option (see 9.9). Ctrl+H

Clicking on Choose curve on the info palette

(fig. 8.36) allows you to toggle through the

following three modes:

Both Inset and Standoff curves are attached to the

frame shape and are moved and resized when the

frame is moved and resized.

Editing the Inset Curve
To edit the Inset curve, click on the object you

wish to edit and then toggle the Choose curve

button on the info palette until you are in the Inset

mode.

The Inset curve is positioned around the inside of

the frame and repels the text flowing in the frame.

By default it is the same shape as the frame, but

positioned 1mm in from the edge of the frame

(fig. 8.37). The default inset distance is specified

on the Modify dialogue box (see 9.1). F7

The frame outline is drawn in grey with the Inset

curve drawn in grey with the end points in blue.

You can now edit the Inset curve using the same

operations described on the previous pages

(fig. 8.38).

If you wish to reset the Inset curve to its original

shape and position, reset the Inset value on the

Modify dialogue box to 1mm.
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Fig. 8.37 - The outer line is the frame guideline
and the inner line is the default Inset curve.

Fig. 8.38 - The Inset curve has been edited
causing the text to flow inside the new shape.

Default mode: this allows you to edit

the shape of the object.

Inset mode: this allows you to edit

the Inset curve.

Standoff mode: this allows you to

edit the  Standoff curve.



Editing the Standoff Curve
MenuêObjectêText flow Ctrl+Shift+T

To edit the Standoff curve, click on the object you

wish to edit and then toggle the Choose curve

button on the info palette until you are in the

Standoff mode.

The Standoff curve is the positioned around the

outside of the frame and repels text flowing

around the outside of the frame. By default it is

the same shape as the frame, but positioned 1mm

out from the edge of the frame (fig. 8.39). The

default standoff distance is specified on the

ObjectêText flow dialogue box (see 9.7).

The frame outline is drawn in grey with the

Standoff curve drawn in grey with the end points

in blue. You can now edit the Standoff curve

using the same operations described on the

previous pages (fig. 8.40).

If you wish to reset the Standoff curve to its

original shape and position, reset the Standoff

value on the Text flow dialogue box to 1mm.

Editing Picture Runaround
The Picture option on the ObjectêText flow

dialogue box automatically modifies the default

Standoff curve so that it follows the shape of the

picture instead of the frame. Using the facilities

described in this chapter you may edit the

Standoff curve to fine-tune the runaround shape to

your exact requirements.
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Fig. 8.39 - The inner line is the frame guideline
and the outer line is the default Standoff curve.

Fig. 8.40 - The Standoff curve has been edited
causing the text to flow around the new shape.



Notes:
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